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1.28.07 - Yahoo Finance

Carl Howe (Blackfriars Communications) sub-
mits: Those guys over at Apple Recon seem 
to have a good rumor pipeline going. Just 

the other day, they found an Apple source who 
said that Apple TV is blowing away expectations, 
with the first 100,000 units already sold and Apple 
doubling that number on the next manufactur-
ing run. Current thinking is that Apple (NasdaqGS: 
AAPL) will sell a million by next Christmas.
 What’s the irresistable attraction of Apple TV? 
Well, Alan Graham over at ZDNet has done the 
math, and figured out that Apple TV’s value 
proposition is just downright cheaper than buy-
ing cable TV service, assuming you only regularly 
watch a few shows, even if you buy every single 
show of your favorite series from iTunes (i.e., you 
don’t catch up on them by watching them for 
free on the Web or the like). Further, watching 
TV via Apple TV and iTunes means that you get 
to watch the shows when you want to, not when 
they are broadcast. And reruns? Well, you own 
the shows -- watch them whenever you want.
 I currently subscribe to both cable TV and TiVo 
(NasdaqGM: TIVO), and I’m finding I’m watching 
much less TV than I used to. Most of the content 
Comcast bundles in my subscription doesn’t 
interest me. The TiVo picks up my favorite series 
shows, and the nightly news, and those consti-
tute most of my TV watching; the rest is DVDs or 
on-demand TV (which I can also get via iTunes). 
So remind me again why I need 140 digital chan-
nels, especially when 100 of them are watching 
people yelling at each other.
 Blackfriars predicted that an Apple TV network 
based on iTunes was coming nearly a year and a 
half ago. And when Jobs introduced the actual 
Apple TV product, I said that it was a shot across 
the bow of competing consumer electronics 
companies. I’m now beginning to believe that 
that shot wasn’t a warning -- it was the start of 
a slow and steady attack on cable TV’s business 
model, as well as the recent telco must-lose-
money TV initiatives. You know what? With Apple 
introducing a product that gives TV viewers what 
they want when they want it and for less money 
than their competitors, it just might work.

Apple TV Is Nothing Less Than 
an Attack on Cable TV’s 
Business Model

2.5.07 - The Associated Press

IPod maker Apple and the manager of The 
Beatles’ Apple Corps resolved their long-sim-
mering dispute on Monday about who has 

the right to the Apple trademark.
 The settlement offered 
greater hope to fans of 
George, Paul, John and 
Ringo that the two sides 
could now focus on 
permitting downloads 
of the band’s music 
through the iPod mak-
er’s iTunes online music 
service. The catalog of 
all Beatles songs, includ-
ing “Let it Be,” “Get Back” and “She Loves You,” is 
the largest holdout from iTunes and other online 
music services.
 The new settlement replaces the companies’ 
1991 agreement and gives Apple Inc. ownership 
of all the trademarks related to “Apple,” mean-
ing it will continue using its name and logos on 
iTunes. In addition, Apple Inc. will license certain 
of those trademarks back to Apple Corps for 
their continued use.
 This settlement ends the ongoing trademark 
lawsuit between the companies, with each pay-
ing its own legal costs. Further terms weren’t 
disclosed.
 “We love the Beatles, and it has been painful 
being at odds with them over these trademarks,” 
said Steve Jobs, Apple’s CEO. “It feels great to re-
solve this in a positive manner, and in a way that 
should remove the potential of further disagree-
ments in the future.”
 Neil Aspinall, manager of Apple Corps, said 
the company was glad to resolve the dispute.
“The years ahead are going to be very exciting 
times for us. We wish Apple Inc. every success 
and look forward to many years of peaceful co-
operation with them,” he said.
 The joint announcement from Apple Inc. and 
Apple Corps, however, was silent on the pros-
pects of Beatles downloads.

Apple, Beatles Settle
Trademark Suit 1.22.07 - Gregg Keizer - InformationWeek

Apple will charge current Mac users $29 for 
the final version of its dual-boot Boot Camp 
software, a Mac enthusiast Web site reported 

Saturday.
 According to MacScoop, Apple will move Boot 
Camp out of its current beta status and into final form 
for the “Tiger” version, or 10.4, of MacOS X and charge 
users $29 for the software. At the same time, it will 
bundle a version of the final software into Mac OS X 
10.5, or “Leopard,” later this spring at no extra charge. 
Apple has not yet set a release date for Leopard.
 Boot Camp, which Apple introduced in April 
2006, is a set of instructions and an assistant ap-
plication that walks users through partitioning a 
Mac’s hard drive, burning a CD with the neces-
sary boot drivers, and installing
 Windows XP SP2. With Boot Camp, users can 
launch either Windows or the Mac OS when they 
turn on the computer.
 Apple has never specified whether Boot Camp 
would remain free when it left beta test, but 
MacScoop’s sources claim the Cupertino, Calif., 
computer and electronics maker will charge $29 
for the final software for those who add it to exist-
ing systems. The forthcoming Leopard will include 
the Boot Camp feature, and will likely add support 
for Windows Vista when Mac OS X 10.5 launches.
 Apple didn’t immediately respond to a request 
for confirmation.
 Last week, reports circulated that Apple 
would levy a fee to enable faster wireless tech-
nology already inside newer Macs; Apple quickly 
confirmed the $1.99 charge.

Report: Apple To Charge To
Download Boot Camp Final

1.30.07 -Peter Cohen and Jim Dalrymple - Playlist

Apple on Tuesday announced that the 
iPod Shuffle is now available in five 
colors; Blue, pink, green, orange and the 

original silver. The 1GB iPod shuffle costs $79.

iPod shuffle now comes in five colors
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1.30.07 - Dan Frakes - PLAYLIST

As more and more people own iPods, Zens, 
and Zunes, and use those players in noisy 
environments, in-ear-canal headphones—

commonly known as “canalphones” or “in-ear 
monitors”—have become increasingly popular. 
As a high-quality option for replacing the cheap 
headphones included with portable music and 
media players, the selection of canalphones has, 
over the past decade, evolved from a few expen-
sive models to a wide-open market with dozens 
of choices across a wide price range.
 Still, it’s fair to say that most people aren’t 
familiar with in-ear-canal headphones, which 
differ considerably from traditional headphones 
in terms of fit, sound quality, and use. We’ve put 
together this primer to help you understand 
what makes canalphones unique and why you 
may (or may not) want to give them a try.
 What are in-ear-canal headphones? Unlike 
standard headphones, which use relatively 
large drivers (speakers) and fit on top of or 
around your ears, or earbuds, which use fairly 
small drivers and sit loosely in your outer ears, 
in-ear-canal headphones use very small drivers 
and actually fit inside your ear canals (thus the 
name canalphones). In fact, using either rub-
ber eartips in various sizes, or foam eartips that 
expand to fit any size ear canal, canalphones 
are designed to seal your ear canals closed, 
blocking external noise—much like a pair of 
earplugs. In fact, many canalphones look and 
fit just like earplugs.
 Some of the companies that sell true in-ear-
canal headphones include Altec Lansing, Ety-
motic, Future Sonics, Shure, Ultimate Ears, and 
XtremeMac. Prices range from $100 to $900.

and the way canalphones seal in your ear canals, 
they have the potential to produce very good audio 
quality—some in-ear-canal headphones are among 
the best headphones on the market, period.
 What are the disadvantages of in-ear-canal 
headphones? Canalphones aren’t without their 
drawbacks. For example, because they seal out 
external noise, you can’t hear what’s going on 
around you, which makes it tough to have a 
conversation—and, worse, makes it unsafe to use 
them in certain environments. (Although Shure’s 
new PTH Control module, which we covered in 
our 2006 Plays of the Year article when we talked 
about the Shure E500PTH, provides a nifty work-
around.) Some people also find canalphones to be 
uncomfortable, as noted below, and they can be 
inconvenient to put in and remove, which makes 
them impractical for environments in which you’ll 
need to do so often. Finally, most in-ear-canal 
headphones suffer—to varying degrees—from 
microphonics, a phenomenon where, because the 
headphones seal so tightly against your ear canals, 
bumps and scrapes to the headphone cables are 
transferred up the cables directly to your ears. 
These sounds can be very distracting, especially if 
you’re engaged in an activity, such as exercise, that 
involves a lot of movement. (Manufacturers have 
tried to reduce microphonics by using different cable 
materials and by using designs that reduce cable 
movement; for example, Ultimate Ears and Shure use 
over-the-ear cable designs.) Related to microphonics, 
some people also experience what is known as the 
occlusion effect, where your voice and other bodily 
noises—breathing, coughing, eating, etc.—seem 
louder or unnatural while wearing canalphones.
 I’ve tried canalphones in the past and found 
them to have horrible bass and poor overall sound 
quality. I mentioned above that in-ear-canal head-
phones are designed to seal in your ear canals. This 
isn’t just important for blocking external noise; it’s 
also vital to getting the best sound quality. When 
you don’t get a good seal, the lower frequencies 
are considerably lacking, if not missing altogether, 
resulting in very poor sound quality. So it’s impor-
tant to find tips—rubber, foam, or custom (see 
below)—that let your in-ear-canal headphones fit 
your particular ear canals well.
 And, of course, as with most audio products, 
sound quality varies between models—in general, 
the more you spend, the better overall sound you’ll 
get. But there are also variations between models 
at similar prices, and some relatively inexpensive 
models hold their own against pricier products. 
That’s where reviews and personal auditions come 
in. And if you were disappointed in the past, the 
good news is that canalphones are constantly 
improving, at both the low and high end; you can 
spend as little as $100 and get impressive perfor-
mance, or you can go all out and get sound quality 
that simply wasn’t available a few years ago.
 Is there a big difference in sound quality 
between cheaper and more expensive models? 
Is it worth it to pay more? In this respect, canal-
phones are no different than any other style of 
headphones: it depends on your ears, your au-
dio source, the kind of music you listen to, and 
the quality of your music files. The better each 
of these is, the more you’ll benefit from—or, 
to put it another way, the more you’ll realize 
the benefits of—better canalphones. If you’re 
perfectly satisfied with 128kbps MP3 files and 
listen mainly to rock and pop, you’ll probably be 
satisfied with some of the less expensive models 
out there. On the other hand, if you rip your CDs 

to uncompressed or lossless music formats, obsess 
over the differences between a headphone jack 
and a line-out, and spend at least part of your 
time listening to well-recorded jazz and classical, 
the benefits of higher-end models will likely be 
obvious. But, again, the proof is in the listening: 
canalphones are must-audition accessories, so 
you should purchase them from a store with a 
good return policy. (HeadRoom is a great Internet 
retailer with a 30-day guarantee on all headphone 
purchases.)

In-ear-canal headphone 
primer

What you need to know about 
in-ear-canal headphones ( “canalphones”)

Canalphones from Ultimate Ears (left), 
Etymotic (middle), and Shure (right).

 What are the advantages of in-ear-canal 
headphones over other styles? Because of their 
unique design, canalphones have a few dis-
tinct advantages over traditional headphones. 
The most noticeable, obvious the first time you 
try a pair of in-ear-canal models, is that they 
block more noise than any other type of head-
phones—far more than noise-canceling and 
“closed” over-the-ear models, and, with a good 
seal, as much as many industrial-level hearing 
protectors. Another is that because they block 
so much external noise, when listening in noisy 
environments, you can listen to music at lower 
levels than with most other types of head-
phones. Finally, because of the technology used 

Examples of eartips for Shure 
canalphones: rubber (top) and 
foam (bottom).

 I’ve tried canalphones in the past and they 
were really uncomfortable. Because you’re stick-
ing in-ear-canal headphones down into your ear 
canals, and using eartips designed to press tight-
ly enough against the walls of your ear canals to 
get a good seal, canalphones can feel quite un-
comfortable when you first start using them. In 
fact, some people never get used to this feeling. 
However, in my experience, most people accli-
mate to the sensation after a while. (Personally, 
I always have some degree of minor discomfort 
when I first put them in, but it goes away after 
a few minutes—either that or the quality of the 
sound is effective at distracting me!)
 In order to make it easier to get a comfort-
able fit, most canalphones include a selection of 
eartips—the actual “plug” that covers the head-
phone-driver enclosure and that sticks in your ear. 
(Some vendors, such as Shure, call them sleeves.) 
It’s common for this selection to include several 
sizes of silicone/rubber tips, each of which usually 
features two or three ridges or flanges, as well as 
a set of one-size-fits-all foam tips which expand 
to fit whichever ears they find themselves in. 
Some vendors, such as Shure and Ultimate Ears, 
also include no-flange rubber tips in several sizes. 
You try out all the various tips to find the one that 
offers the best seal and the best comfort.
 (I’m personally a big fan of foam tips. They 
aren’t quite as comfortable as silicone/rubber 
tips when you first insert them, but in my expe-
rience it’s much easier to get a good seal with 
foam, since it expands to perfectly fit your ear 
canals. And once you’ve worn foam eartips a few 
times, your ears get used to the feel.)

An example of custom earmolds, 
these on Ultimate Ears’s UE-5 
Pro.

 Another option, if you’re serious about your 
listening, is to buy custom earpieces. Available 
from some canalphone vendors directly, or as 
after-market accessories from third-party ven-
dors, custom earpieces replace the stock rub-
ber or foam eartips with versions that fit your 
individual ears perfectly. They require a visit to 
an audiologist, who fills each of your ears with 
a quick-setting foam; after ten minutes or so, 
the audiologist removes the now-rigid foam 
mold from each ear and then sends it off to the 
earpiece manufacturer, which creates custom 



based on those molds. The advantages of 
these earpieces are two-fold. First, because 
they’re made for your ears, they tend to fit 

perfectly; most people who’ve tried them will tell 
you that they’re much more comfortable than 
rubber or foam tips. Second, because of the good 
fit, they tend to let your canalphones shine, so to 
speak—you’ll get better sound quality than with 
stock tips. Custom earpieces are available in soft 
or hard versions; the cost—including the earpieces 
and the audiologist visit—ranges from as little as 
$150 up to several hundred dollars, depending on 
material and vendor.
 I’ve heard that canalphones are dangerous, 
given that they sit inside your ear canals. Not 
necessarily. Although it’s true that in-ear-canal 
headphones place their drivers very close to your 
eardrums relative to other types of headphones, 
and thus have the potential to damage your ears 
if you listen too loudly, the risk of canalphones 
is often overstated. The main reason for this is 
that, because they block a significant amount 
of external noise, canalphones can often be 
enjoyed at much lower volume levels than tra-
ditional headphones. You don’t have to “drown 
out” the other noise in your environment just to 
enjoy your music—you can get the same effec-
tive volume level at much lower actual volumes.
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Canalbuds from V-Moda (left) and Sennheiser (right).

 What are these canalbud things? Over the 
past few years, an increasingly popular variant of 
in-ear-canal headphones has been what we call 
canalbuds. Halfway between earbuds and true 
canalphones, canalbuds use small rubber eartips 
that sit just inside the ends of your ear canals. 
They don’t seal out as much external noise as 
full-fledged canalphones, and they generally 
don’t sound quite as good, but they’re easier 
to put in and take out, are less expensive, and, 
perhaps most important, are more comfortable 
for many listeners than true in-ear-canal models. 
Good examples of this style of headphone are 
Sennheiser’s CX 300, Sony’s EX 70 and 80 lines, 
and V-Moda’s Bass Freq and Vibe. Prices of can-
albuds range from under $50 to $100.
 So what’s your take on canalphones? We like 
’em. Seriously—most Playlist editors, as well 
as a good number of editors over at our sister 
publication, Macworld, have at least one set of 
canalphones, and a number of us have multiple 
models. You can also find around the office a 
good number of sets with custom earpieces. In 
many ways, in-ear-canal headphones combine 
the best of other types of headphones—great 
sound quality, stellar noise isolation, low power 
requirements, and even good comfort—in an 
ultra-portable package.
 We’ve got a good number of the latest and 
greatest canalphones in the queue for review, so 
be sure to keep an eye on Playlist and check out 
the Playlist Product Guide for the latest reviews.
[Dan Frakes is Playlist’s senior reviews editor.]

I was looking for a way to create a password protected folder on my Mac for storing things such as a 
password list and anything else that may be personal in nature.  I was surprised just how easy it is. 
If you are running MacOS version 10.3 (Panther) or 10.4 (Tiger), simply use Disk Utility, which comes 

standard.  I’ve read that this procedure isn’t available if you are running MacOS 10.2 (Jaguar), so you 
might have to upgrade to OS 10.3 or .4 in this case. (Shareware guru, Ray Kallman, informs there are 
free or very low cost applications (with encryption) that will create disk image files in OS 10.2. DMG 
Maker being one: http://www.pliris-soft.com/products/dmgmaker/index.html.
 In addition to the other useful things Disk Utility can do, it uses an intuitive method to create stand-alone 
archive files. These archives are called disk images (“filename.dmg”), and they can be encrypted such that 
they are accessible only by a password you select. 
 Okay, how do we set up an encrypted archive on a Mac?  Here are basic instructions:
1.  Open the Disk Utility program.
 In Finder, open the Go menu and select Applications. Scroll until you see the Utilities folder, and open it 
by double-clicking it. Scroll until you see Disk Utility, and open it also by double-clicking. 
2. Create a new disk image.
 Now that Disk Utility is open, first verify that NONE of the disks, volumes, or images in the left-hand 
side-bar is selected. If one is, then click in the white space near the bottom of the side-bar to de-select 
all disks, images, and volumes. This is important for the creation of the new image. 
 Then, click the New Image button  on the Disk Utility toolbar. You should see 
a small window slide down over top of Disk Utility. 
 Customize your disk image.
 •  In the Save As: field, type a descriptive name, e.g., something clever like “lockedfiles”. 
 •  In the Where: menu, select where you want the archive to be created (you can always move  
  the archive later -- for now, select Desktop). 
 •  In the Size: menu, select the desired size. 
 • Choose a size for the disk image that is larger than the cumulative size of the files you   
  want to store inside it.  Note: the disk image will take up as much space on your hard drive as 
  you specify in the Size: field – regardless of how many or few files you store inside it at any given moment.
 •  In the Encryption menu, select the desired level of encryption. In most cases, your only option  
  will be AES-128 (recommended), which is fine. 
 •  In the Format menu, select read/write disk image. 
 •  When you are done entering these settings, click Create. 
You will see a progress bar while Disk Utility creates your archive, and then a small window will ap-
pear, prompting you to:
3. Enter a Password.
Select any password you like. DO NOT ADD YOUR PASSWORD TO THE KEYCHAIN. Ensure that the 
check-box labeled Remember Password (add to keychain) is UNCHECKED.  If you don’t do this, MacOS 
will supply your password to anyone trying to access your encrypted archive.
Click OK .
4. Add Files to Your Encrypted Disk Image.
If you saved the disk image to your desktop, you should see two new icons there.
5. One of them is named something like lockedfiles.dmg,
 
 
... and the other one will simply be named lockedfiles. 
The former of these two files is the one you will always maintain. The latter of these two files is the mounted 
disk image of your encrypted archive: this is where you can add and remove files. Double-clicking the mounted 
image will open a window into which you can simply drag and drop the files you want to protect.
6. Encrypt!
When you are ready to lock up your files, eject the mounted disk image by dragging it into the Trash on the 
Dock (this drives PC users to distraction by the way). The mounted image will disappear, but the encrypted 
archive “lockedfiles.dmg” will remain. Then simply make sure that no un-encrypted versions of your files are left 
on your computer, and your data is now safely locked behind good encryption secured by your password.  
7. Decrypt!
To retrieve your protected files, double-click the encrypted .dmg file you’ve created. A dialog box 
entitled “Authenticate” will appear asking for your password.  Enter your password and click “OK.” 
You will be required to enter your password before your files are accessible.  Leave the “Remember 
password” checkbox blank!  A disk image will appear on the Desktop containing your protected files.
8. Notes:
•  When a file is dragged to the mounted disk image a copy is made and the original remains unprotected 
and available for access.  Be sure to delete the unprotected copy and empty it from the Trash.
•  This file is very versatile and there are various ways to use your encrypted .dmg file depending 
on your needs and the way you like to use your Mac.  For example, I keep the file in my Documents 
folder and an alias of it on my Desktop (not having actual files on the Desktop speeds up a Mac, but this 
is a different subject).  
•  Another example of how versatile this file can be occurs when one creates an MS Word document in it 
and later wishes to access this document via the recently viewed items in the File menu of MS Word.   Before 
opening the file, the operating system will ask you to enter your password.  (This process in the “Recent items” 
function under the Apple menu in OSX will not work unless the archive has been opened first.)

Mac OS X File Encryption TarMac member - Larry McCullough

lockededfiles.dmg

lockedfiles
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The Tarmac Vaporware Gazette, named in honor of past 
president Jerry Rowe, is published for each meeting by smitty’s 
printshop, a non-existant shop specializing in things of little 
or no importance to the world at large. Send your comments, 
good or bad, to smittysprintshop@mac.com. 
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Peter Cohen- MacWorld

If you want to run Microsoft’s new Vista operating 
system on a Mac using Parallels Desktop for 
Mac, you’re going to have to buy the Enterprise 

or Ultimate editions. Parallels’ Ben Rudolph 
recently posted about the issue on the official 
Parallels Virtualization Blog.
 With the release of Vista, Microsoft has reworded 
its End User License Agreement (EULA) to forbid 
the use of Vista Home Basic and Home Premium 
Editions with virtualization products like Paral-
lels and VMware. Macworld has confirmed the 
information with a Microsoft spokesperson. 

“USE WITH VIRTUALIZATION TECHNOLOGIES. 
You may not use the software installed on the 
licensed device within a virtual (or otherwise 
emulated) hardware system,” reads the EULA.

 That doesn’t preclude Vista Home editions 
from being installed on Macs running Boot Camp, 
however, since Boot Camp isn’t a virtualization or 
emulation technology — instead, it makes Win-
dows run natively on the Mac. For now, however, 
Boot Camp is still in beta development, and still 
officially works only with Windows XP.
 Meanwhile, the EULA included with Vista En-
terprise and Ultimate editions allows that oper-
ating system software to be installed on virtual 
or emulated hardware systems.
 “In short, this means that if you’re a user and 
you want to run Vista virtually, you MUST buy the 
highest end versions of Vista, or you’ll be in viola-
tion of the Microsoft EULA,” writes Rudolph.

Vista Home license forbids 
virtualization

 “Most customers using this technology are 
primarily business users addressing application 
compatibility needs, or technology enthusiasts,” 
said a Microsoft spokesperson. “So virtualization 
will be supported in Microsoft Windows Vista Ul-
timate and Vista Business SKUs. Home users have 
rarely requested virtualization and so it will not 
be supported in Microsoft Windows Vista Home 
Basic and Home Premium SKUs.”
 The issue for users is price: Microsoft sells its 
Home editions of Vista for $199 or $239, while 

Business and Ultimate editions cost $299 and 
$399 respectively.
 “To me, this strategy could hold back users 
who embrace cutting-edge technologies like 
virtualization, which means they won’t upgrade 
to Vista. This means that Microsoft has effec-
tively lost an upgrade customer (in the case of 
Windows PCs) or an entirely new customer (for 
Mac and Linux users),” writes Rudolph.

and two examples...

Creating a new roll in iPhoto

 A good way of classifying you pictures in 
iPhoto without much effort is by using film rolls. 
This gives you a more understandable library 
where you don’t have 2500 pictures in a big 
chunk. It kind of separates the events without 
the need of creating an album for each one. You 
can enable film rolls by choosing “Film Rolls” in 
the “View” menu. When you import pictures 
from your camera, the rolls will be created au-
tomatically. This works amazingly well until you 
import the content of your camera memory card 
and you realize you didn’t have time to import 

before and you are now stuck with two events in 
a single roll. I used to do it in a really complicated 
manner. I imported any picture from my camera 
and it would create a roll. I deleted the picture and 
transferred one of the event to the new roll. That 
was until I found the simplest way imaginable of 
doing it: you select the pictures you want in the 
roll with two events and you choose “Create a 
Film Roll” from the “File” menu. Boom, you now 
have your two events in separate and organized 
rolls.

Zoom in any application

 You can zoom in, anywhere on your system, 
by holding Ctrl and scrolling up with a scroll 
mouse (or with a scrolling trackpad). To unzoom, 
you hold Ctrl and scroll down until it is back to 
normal. It is a pretty useful feature but it is not 
perfect. One of the problem that I hope will be 
solved in Leopard is that the text doesn’t stay 
clear. The “resolution independence” feature in 
Leopard is most likely the solution. Basically, the 
problem with this is that the image is stretched 
and you don’t get any additional pixel. It can 
still be useful though. Unfortunately, I cannot 
really show you the effect with a screenshot so I 
suggest try it out!

Here is a widget I found recently that provides 
daily tips to make using your Mac easier. It can be 
downloaded from:

www.apple.com/downloads/dashboard/blogs_
forums/anewmactipeveryday.html


